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Abstract – This study is aimed to analyze factors that determine debt maturity. 
Since the asymmetric information level in Asia Pacific is higher compare to U.S. 
and Europe, the debt maturity decision become riskier. This study is using 13 
different regression model, all sample, listed and crisis, listed and non crisis, non 
listed and crisis, non listed and non crisis, listed with performance and crisis, 
listed with performance and non crisis, listed high leverage, listed high leverage 
and crisis, listed high leverage and non crisis, listed low leverage, listed low 
leverage and crisis, listed low leverage and non crisis. This paper investigates the 
determinants of debt maturity for all loan sample in Asia Pacific during 2006-
2010, using ordinary least square method to support the results. Based on the 
research, lenders are proven inable to differentiate between good quality 
borrowers and bad quality borrowers. Thus, in terms of debt maturity policy, the 
risk is higher for lenders compare to borrowers. 
Keywords: Asymmetric Information, Maturity, Pecking Order 
 
 
INTRODUCTION 

Debt maturity is an important aspect of loan transaction, since it is 
affecting the firm’s value (Megginson, 1997). Smart, et al. (2004) explained that 
the amount of paid interest become higher for a longer debt maturity period, 
which will increase cost of debt and cost of capital thus affecting the firm’s value. 

Research regarding debt maturity in U.S. and Europe has been commonly 
conducted, i.e.: asymmetric information and moral hazard (Custodio Claudia, 
liquidity risk (Diamond, 1991), risk and asymmetric information (Berger, et al., 
2004), maturity structure (Barclay, et al., 1995), refinancing risk and cash 
holdings (Harford, et al., 2011), leverage and firm investment (Dang, 2011), 
maturity structure and credit quality (Gopalan, et al., 2010), capital structure 
(2011), and growth opportunities, choice of leverage, and covenant (Billett, et al., 
2007). But for Asia region, in particular Asia Pacific, debt maturity research is 
uncommon. That become the purpose of this study to test factors that determine 
debt maturity in Asia Pacific. It become more important and unique to conduct 
this research, since the previous study done in U.S. and Europe has a low 
asymmetric  factor compare to Asia Pacific with a high asymmetric information 
level. This statement also supported by Tanjung (2012) that stated “Asia Pacific is 
a high risk region, with a lower transparancy compare to U.S. and Europe. Moral 
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hazard is easier to be found in developing countries in Asia with a high 
asymmetric information level”. 

A few examples of debt maturity study can be found as below: Research 
done by Custodio, et al. (2011) on corporate debt maturity in U.S. industries from 
1976 until 2008, exclude financial corporates (SIC Code 6000-6999) and utility 
corporates (SIC Code 4900-4999), shown that size, abnormal earnings, asset 
maturity, and leverage variables, have a positive and significant effect on debt 
maturity.  While other variables such as market to book, volatility, R&D, and term 
spread indicate a significantly negative effect on debt maturity, except for term 
spread variable that turns out to be insignificant. 

Wang, et al. (2010) study debt maturity structure based on macro economy 
variable in all listed firms in China from 1999 until 2005, not including financial 
corporates and other eliminated firms that don’t match the criteria. The conclusion 
from the research indicate that variables like size, asset maturity, ROE, and macro 
tax burden, have a significantly positive effect on debt maturity, except for ROE 
that shown insignificant effect. Other variables like GDP, inflation, and money 
supply have a negative and significant effect on debt maturity. Independent 
variables used in this study are: LEVERAGE variable, SIZE variable, 
PROFITABILITY variable, and COUNTRY RISK variable.  

 
THEORETICAL FRAMEWORK 

Theories used in this study are asymmetric information and pecking order 
theory, where asymmetric information not only caused adverse selection and 
moral hazard, but also agency problem.  

 
Leverage effect on Debt Maturity 

Barclay and Smith (1995), Stohs and Mauer (1996) stated that monthly 
measured debt maturity will increase in the same time with the increasing 
leverage measured by debt ratio. Antoniou, Guney and Paudyal (2006) also 
conclude that leverage has a positive effect on debt maturity. Firm with high 
leverage tend to have a high default risk, thus have a long debt maturity. While 
smaller firm have a low leverage with low default risk which results on short debt 
maturity.  

Barclay et al. (2003) recommend firm with high liquidity risk and high 
leverage to avoid short term debt, thus leverage and debt maturity can be use as a 
strategy to solve lack of investment issue.  
H1: Leverage is assumed to have a positive effect on debt maturity. 
  
Size effect on Debt Maturity 

Study by Yanhui Wang, et al. (2010) indicates that size measured by 
logarithm of total assets, has a positive effect on debt maturity. Big firm tend to 
have a low credit risk causing lenders to give long debt maturity. In the contracry, 
for a small firm with a high credit risk, lenders will give short term maturity. 
Custodio, et al. (2011) also agreed that size has a positive effect on debt maturity. 
Small firm also most likely have a high asymmetric information which increase 
the risk and causing lenders to give short debt maturity. 
H2: Firm’s size is assumed to have a positive effect on debt maturity. 
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Profitability effect on Debt Maturity 
Myers and Majluf (1984) stated that there is a negative relationship 

between profitability that is measured by ROA, with debt maturity. The reason 
behind it is because a more profitable firm tend have a smaller amount of loan 
which causing them to prefer a short maturity. According to pecking order theory, 
firm with high profitability most likely to prefer capital structure using retained 
earning to lower debt amount, and continuously borrow small amount of debt with 
a short maturity. Baum, et al. (2007) study shown that when firm’s profitability 
increase, they will borrow small amount of debt with short maturity. 
H3: Profitability is assumed to have a negative effect on debt maturity. 
 
Country Risk effect on Debt Maturity 

According to Marciano (2012), high level of country risk that is measured 
from scale 0 to 5 (ordinal), will results in a high level of firm’s risk and default 
risk, caused bank to request repayment at earliest time, which means the debt 
maturity will become shorter. This goes along with Joshua Abor, et al. (2009) 
study that indicates default risk to have a negative effect on debt maturity. 
H4: Country risk is assumed to have a negative effect on debt maturity. 

This study also used control variables such as : listed, secured, amount, 
senior, syndicated, debt repayment, working capital and takeover. 

 
RESEARCH METHOD 
Data Collection 
 Data used for this study are collected from dealscan database, compiling 
corporates in Asia Pacific that act as a borrower from 2006 until 2010. In total, 
there are 1, 058 loan divided into 12 sub samples, where 6 sub samples are ranked 
based on their level of uncertainty and level of asymmetric information, as shown 
in the picture below: 

 
Picture 1 & 2 

Sub Sample based on level of uncertainty and level of asymmetric information (left) and Sub 
Sample based on level of uncertainty and level of financial risk (right)  

(Source: compiled from different sources (attached)) 
 While the other 6 sub sample are categorized based on level of uncertainty 
and level of financial risk as shown in picture 3 below. But, 2 sub sample from the 
total 6 in that category, are divided based on the average of their leverage. While 
the other 4 sub sample are divided based on crisis and non-crisis. 
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Data Analysis 
 The first step is to decide which regression model will be used for this 
study. There are 13 regression model to test the hypothesis: 
(1) All sample  

DEBT MATURITY = 0 + 1LISTED + 2Log(AMOUNT) + 3SENIOR + 
4SECURED + 5SYNDICATE + 6DEBT REPAYMENT + 7TAKEOVER 

+ 8WORKING CAPITAL + 9COUNTRY RISK +  
(2) Loan history for listed and crisis  

DEBT MATURITY = 0 + 1Log(AMOUNT) + 2SECURED + 
3SYNDICATE + 4DEBT REPAYMENT + 5WORKING CAPITAL + 
6COUNTRY RISK +  

(3) Loan history for listed and non crisis 
DEBT MATURITY = 0 + 1Log(AMOUNT) + 2SENIOR + 3SECURED + 

4SYNDICATE + 5DEBT REPAYMENT + 6TAKEOVER + 7WORKING 
CAPITAL + 8COUNTRY RISK +  

(4) Loan history for non-listed and crisis  
DEBT MATURITY = 0 + 1Log(AMOUNT) + 2SENIOR + 3SECURED 
+ 4SYNDICATE + 5DEBT REPAYMENT + 6WORKING CAPITAL + 

7COUNTRY RISK +  
(5) Loan history for non-listed and non-crisis  

DEBT MATURITY = 0 + 1Log(AMOUNT) + 2SENIOR + 3SECURED 
+ 4SYNDICATE + 5DEBT REPAYMENT + 6TAKEOVER + 

7WORKING CAPITAL + 8COUNTRY RISK +  
(6) Loan history for listed with performance and crisis  

DEBT MATURITY = 0 + 1Log(AMOUNT) + 2SECURED + 
3SYNDICATE + 4DEBT REPAYMENT + 5TAKEOVER + 6WORKING 

CAPITAL + 7COUNTRY RISK + 8LEVERAGE + 9SIZE + + 10ROA +  
(7) Loan history for listed with performance and non-crisis  

DEBT MATURITY = 0 + 1Log(AMOUNT) + 2SENIOR + 3SECURED + 
4SYNDICATE + 5DEBT REPAYMENT + 6TAKEOVER + 7WORKING 

CAPITAL + 8COUNTRY RISK + 9LEVERAGE + 10SIZE + 11ROA +  
(8) Loan history listed high leverage  

DEBT MATURITY = 0 + 1Log(AMOUNT) + 2SENIOR + 3SECURED + 
4SYNDICATE + 5DEBT REPAYMENT + 6TAKEOVER + 7WORKING 

CAPITAL + 8COUNTRY RISK + 9LEVERAGE + 10SIZE + 11ROA +  
(9) Loan history for listed high leverage and crisis  

DEBT MATURITY = 0 + 1Log(AMOUNT) + 2SECURED + 
3SYNDICATE + 4DEBT REPAYMENT + 5TAKEOVER + 6COUNTRY 

RISK + 7LEVERAGE + 8SIZE + 9ROA +  
(10) Loan history for listed high leverage and non-crisis  

DEBT MATURITY = 0 + 1Log(AMOUNT) + 2SENIOR + 3SECURED + 
4SYNDICATE + 5DEBT REPAYMENT + 6TAKEOVER + 7WORKING 

CAPITAL + 8COUNTRY RISK + 9LEVERAGE + 10SIZE + 11ROA +  
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(11) Loan history for listed low leverage  
DEBT MATURITY = 0 + 1Log(AMOUNT) + 2SECURED + 

3SYNDICATE + 4DEBT REPAYMENT + 5TAKEOVER + 6WORKING 
CAPITAL + 7COUNTRY RISK + 8LEVERAGE + 9SIZE + 10ROA +  

(12) Loan history for listed low leverage and crisis  
DEBT MATURITY = 0 + 1Log(AMOUNT) + 2SECURED + 

3SYNDICATE + 5DEBT REPAYMENT + 5TAKEOVER + 6WORKING 
CAPITAL + 7COUNTRY RISK + 8EVERAGE + 9SIZE + 10ROA +  

(13) Loan history for listed low leverage and non-crisis. 
DEBT MATURITY = 0 + 1Log(AMOUNT) + 2SECURED + 

3SYNDICATE + 4DEBT REPAYMENT + 5TAKEOVER + 6COUNTRY 
RISK + 7LEVERAGE + 8SIZE + 9ROA +  

 
RESULTS 
 In this part of study, the results from 13 models testing will be explain and 
supported with table. The software used in this process is eviews with Least 
Squares method to find factors that determine debt maturity. 

The test results for model 1 indicate that listed variable has a significantly 
negative effect on debt maturity. The reason behind this is because listed firm has 
a better ability to pay their loan, thus causing them to take long term debt. As a 
results, lenders will be more likely to give short debt maturity to borrowers. Log 
(Amount) variable has a positive and significant effect on model number 2, 3, 4, 
6, 7, 8, 10, 12, and 13. This happen because public or listed firm are normally also 
big size firm, so their debt maturity is not affected by the change in the amount of 
loan. The test results indicate that Log (Amount) variable has a positive and 
significant effect on debt maturity on model 1, 5, 9, and 11. It means that in 
general, borrowers that borrow big amount of loan are tend to choose long term 
debt to avoid short term payment. 

Senior variable on model 1, 3, 4, 7, 8 and 10 show significantly negative 
effect on maturity. The reason is because lenders want to have faster monitoring 
on the loan. Diamond (1993) also stated that maturity for junior debt are longer 
than senior debt. Senior variable show positive and significant effect on maturity 
towards model 5, because from the firm’s point of view, loan with longer debt 
maturity will be chosen if the asymmetric information level is higher.  

Secured variable has insignificantly positive effect on model 2, 4, 6, 10, 
11, 12, and 13. Since the loan has a collateral, then the default risk is also higher, 
thus the firms will prefer long term debt. While lender will assume that the firm 
has a better ability to paid the loan since the firms has a collateral 
(Marciano,2008). Since lender doesn’t have enough information about the firm 
situation, their response can be aggresive that causing the insignificant test results. 
For secured variable, the test results indicate that debt maturity has a positive and 
significant effect on model 1, 3, 7, 8, 9. This means that the firm can provide 
collateral to lenders, and the firm will request a longer debt maturity to lenders. 

The test results for secured variable show negative and insignificant effect 
on model 5. Based on the firm’s perspective, since the loan are given with 
collateral, means the company can pay off their debt in short time, thus causing 
them to request for a short debt maturity. But in the contrary, lenders will assumed 
that the firm has a high default risk because they provide collateral in case they 
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can not repay their debt (Marciano, 2008). Incomplete information about the firm 
situation make the lenders tend to have aggresive response thus causing the 
insignificant test results. 

Syndicated variable has a significantly positive effect on model 1, 2, 3, 4, 
6, 10, and 12, because syndicated firm send signal to lenders about their company 
safety, which causing lenders to give a long term debt. But aside to that, lenders 
also has a responsibility to conduct routine monitoring since syndicated loan 
means that the firm borrow big amount of loan and lender is incapable to provide 
so they need another lenders to assist them. The conflict of interest will make 
lenders to have aggresive response causing the results to be insignificant. 

Syndicated variable has a significantly negative effect on model 5, 7, 8, 9, 
11, and 13. One of the reasons is explained by Dennis and Mullineaux (1999), 
saying that if there is a significant potency from lead arranger to conduct moral 
hazard in syndicated loan, then a shorter debt maturity can minimize the problem. 
A shorter maturity means there will be more often request from debitor to extend 
the maturity deadline, thus make participant lenders to conduct more often 
monitoring activity (Lasmono, 2010). The conflict of interest will make lenders to 
have aggresive response causing the results to be insignificant. 

Debt repayment variable indicate insignificantly negative effect on model 
2, 6, 9, 12, because firm with debt refinancing as their motivation, will have a 
higher risk compare to other type of motivation, causing the borrowers to get a 
shorter debt maturity from the lenders. The insignificant result is caused by 
lenders’ response seeing the borrowers has a different motive because they are too 
interested in a loan for the purpose of debt consolidation. 

Debt repayment variable as a motive indicate negative and significant 
effect on maturity variable towards model 1, 3, 4, 5, 7, 8, 10, 11, and 13. It show 
that borrowers that has debt repayment as their motive will request a short debt 
maturity. While on lender’s perspective, lenders will choose short term maturity 
considering the high risk and the high need of monitoring. 

Take over variable show positive insignificant results on model 3, 6, and 
9, because in general loan for take over purpose is riskier compare to other type of 
purpose, thus the borrowers will prefer to have  along debt maturity. It is also 
supported by Booth and Booth (2002) study that stated different of interest, will 
create aggresive response from lenders, thus the results become insignificant. 

Take over variable indicate insignificantly negative results on model 1, 5, 
and 12. Evelyn (2006) explained that loan for take over purpose usually contain 
high risk, means that the borrowers will get short maturity from lenders. But 
because take over involving take over process for all shares by one or several 
persons, then the ownership of the firm is automatically change from public 
become non public., because the lenders will have aggresive response caused by 
the ownership change, which means the results will be insignificant.  

Take over variable show negatife and significant effect on model 7, 8, 10, 
11, and 13. The reason for this is because loan for take over purpose is riskier 
compare to other type of purpose, thus the borrowers will get short maturity from 
lenders. 

Working capital variable indicate insignificant positive effect on model 2. 
Purnomo (2012) stated that high working capital indicate lower risk thus the firm 
should be able to get long term maturity. While  Evelyn (2006) explained that the 
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borrowers will prefer to have a short term maturity because working capital is 
fund by short term financing, means that the borrowers will get a short term 
maturity. The lenders will have aggresive response caused by the different of 
interest, which means the results will be insignificant. Working capital variable as 
a purpose of loan indicate negative and significant effect on maturity variable 
towards model 1, 3, 4, 5, 11, and 12, because the nature of working capital is short 
term financing, thus the borrowers will borrow with short term maturity and 
lenders will granted their request. 

Working capital variable as a purpose of loan indicate positive and 
significant effect on maturity variable towards model 7, 8, 10. The reason for 
borrowers action is to invest money obtained from short term financing, and in the 
end it can be use to repay the loan and generate long term revenue. It also align 
with the concept of loan for borrowers, which stated that repayment will be done 
in the future if long term maturity become an option.  

Working capital variable show insignificantly negative effect on model 6. 
Evelyn (2006) tried to explain the reason by outlining the reason borrowers prefer 
short term maturity is laid on the nature of working capital that is fund by short 
term financing, thus the borrowers will get short term maturity. While for 
Purnomo (2012) stated that high working capital means the firm’s risk is low, thus 
the firm should get loan with long maturity.  Sedangkan menurut Purnomo (2012) 
dikatakan jika working capital tinggi maka risiko perusahaan akan kecil dan 
seharusnya perusahaan memperoleh pinjaman dengan maturitas yang panjang. 
The lenders will have aggresive response caused by the different of interest, which 
means the results will be insignificant. 

Country risk variable indicate positive and insignificant effect on model 2, 
8, and 12. This results is caused by a high level of country risk that makes the firm 
to choose loan with long debt maturity, and the creditor will granted the request 
because they also need income. By giving a long term maturity, means the 
creditor is ignoring the country risk level in that particular country. While for 
model 1, 3, 5, 7, 10, 11, and 13, the results is insignificantly negative, means that 
in a high country risk case, the company will get loan with short term maturity 
because the firm need fund to survive from bankrupcy. By taking short term 
maturity, the firm is ignoring the country risk level, which can cause bankrupcy. 
Means that the result of this study and Abor et al. (2009) study is insignificant. 
Country risk variable show positive and significant effect on maturity towards 
model 4, 6, and 9. The reason is because high level of country risk will motivate 
the borrowers to choose long term maturity, thus every borrowers will request for 
a loan as an investment to avoid default risk. 

ROA, leverage and size variables are insignificant on model 6, 8, 10, 11, 12, 
and 13. While for model 7, the insignificant results is related to leverage and 
ROA, and only leverage that has insignificant results on model 9. Atmojo (2004) 
that the test for listed borrowers sub sample by adding common financial 
variables, indicate that financial ration is irrelevant to measure the risk level of 
loan. The reason is because from listed borrowers sub sample with financial ratio, 
we can see that lenders don’t give enough attention on listed borrowers’ financial 
performance, and most likely failed to differentiate between low risk listed 
borrowers and high risk listed borrowers. 
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Size variable show negative and significant results on model 7 and 9, 
becayse borrowers from big size firm tend to have big asset means they can 
generate high sales. It means that the firm have a capability to achieve high profit 
thus able to repay the loan sooner compare to borrowers from small size firm. 

ROA variable has a negative and significant effect on maturity towards 
model 9. It is align with pecking order theory, which stated that high profit firm 
tend to choose fund from retained earning to minimize the debt. As a result, the 
firm will request for a smaller amount of loan with short term maturity. It means 
that hypothesis number 4 that assumed profitability has a negative effect is 
proven.  
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SUMMARY AND CONCLUDING REMARKS  
Based on F hypothesis test, log amount, listed, secured, senior, syndicate, 

country risk, debt repayment, working capital, takeover, leverage, size, and 
profitability, have a significant impact towards debt maturity. 

But under listed low leverage and crisis condition, independent and control 
variable, both have effect on dependent variable (maturity). It means that debt 
maturity can be predict using 12 exisiting models, except for listed low leverage 
and crisis condition. 

Hypothesis testing results with t-test for all sample, listed, senior, debt 
repayment, and working capital variables, has a siginificantly negative effect on 
debt maturity. But for log amount and secure variables, the results indicate 
positive and significant effect on debt maturity. While for syndicated variable, the 
results indicate insignificantly positive effect, and for takeover and country risk 
variables show negative and insignificant effect. And for listed and crisis 
variables, there is none variable that has significantly negative effect on debt 
maturity. But for log amount, secure, and country risk variable, there is a positive 
and significant effect on debt maturity. While for syndicated and working capital 
variables, both indicate positive and insignificant effect, and debt repayment 
variable indicate negatif and insignificant effect. For listed and non crisis, senior, 
debt repayment, and working capital variables, all show insignificant negative 
effect on debt maturity. But secure variable has positive and significant effect on 
debt maturity. While for log amount, syndicated, and takeover variables, the 
results indicate insignificantly positive effect, and country risk variable indicate 
insignificantly negative effect. 

Hypothesis testing with t-test for non listed and crisis, senior, debt 
repayment, and working capital variables, indicate a significantly negative effect 
on debt maturity. But for country risk variable, the result show that there is 
positive and significant effect on debt maturity. Meanwhile for log amount, 
secure, and syndicated variables indicate insignificantly positive effect. And for 
non listed and non crisis, debt repayment, working capital variables, all have 
negative and significant effect on debt maturity. But for log amount and senior 
variables, the results show positive and significant effect on debt maturity. Then 
for secure, syndicated, takeover, and country risk variables indicate that there are 
significantly negative relationship. While for performance and crisis, log amount 
and country risk variables, all have positive and significantly positive on debt 
maturity. While for secure, syndicated, and takeover variables, the results indicate 
insignificantly positive effect on debt maturity, and also for debt repayment, 
working capital, leverage, size, and profitability (ROA) variables, indicate 
negative and insignificant relationship. The test results for secure, syndicated, and 
takeover variables, indicate that there is positive and insignificant relationship 
with debt maturity. For debt repayment, working capital, leverage, size and 
profitability (ROA) variables, the test results indicate that the relationship is 
negative and insignificant. 

Hypothesis testing using t-test for listed with performance and non crisis, 
senior, debt repayment, takeover, and size variables have significantly negative 
effect on debt maturity. But for working capital, and secure variables the results 
indicate positive and significant effect on debt maturity. While for log amount and 
profitability (ROA) variables, the effect on debt maturity is positive and 
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insignificant, where as  for syndicated, leverage and country risk variables, the 
results in negative and insignificant. For listed high leverage, senior, debt 
repayment, and takeover variables, all have negative and significant effect on debt 
maturity. But for working capital and secure variables, the results show positive 
and significant effect on debt maturity. While for log amount, profitability and 
country risk variables, the effect on debt maturity is positive and insignificant. 
While for syndicated, leverage and size variables, the results is insignificantly 
negative. For size and profitability (ROA), the results show negative and 
significant effect on debt maturity. But for log amount, country risk and secure 
variables, the indication show significantly positive effect on debt maturity. While 
for takeover variable, it show positive and insignificant effect, then for syndicated, 
debt repayment, and leverage variables, all show negative and insignificant effect. 

Hypothesis testing using t-test for listed high leverage and non crisis, debt 
repayment, senior, and takeover variables, all show significantly negative effect 
on debt maturity. But for working capital and secure variables, the results show 
positive and significant effect on debt maturity. While for syndicated, log amount, 
and profitability (ROA) variables, the indication show positive and insignificant 
effect on debt maturity. And for leverage, size and country risk variables, the 
results is negative and insignificant. From hypothesis testing using t-test, the 
indication show negative and significant effect on debt maturity for listed low 
leverage, debt repayment, takeover, and working capital variables. But for secure 
and log amount variables, the effect on debt maturity is significantly positive. 
While for leverage and size variables, the indication show positive and 
insignificant effect. Profitability (ROA), country risk, and syndicated variables 
show negative and insignificant effect as a results. For listed low leverage and 
crisis variables, the results show positive and significant effect on syndicated 
variable, while working capital variable show negative and significant effect on 
debt maturity. While for log amount, secured, and country risk variables, the 
effect is insignificantly positive, and for profitability (ROA), size, leverage, debt 
repayment, and takeover variables, the indication is significantly negative. For 
listed low leverage and non crisis variables, the test results show positive and 
significant effect on secured variable, where debt repayment, takeover, and 
profitability (ROA) variables show negative and significant effect on debt 
maturity. For log amount, and leverage variables, both have positive and 
insignificant effect, while for size, syndicate and country risk variables, the results 
show negative and insignificant effect.  

The coefficient of determination (R2) for all sample test is 0.0919, for 
listed and crisis test is 0.048177, for listed and non crisis test is 0.139724, for non 
listed and crisis test 0.102747, for non listed and non crisis test is 0.059279, for 
listed with performance and crisis test is 0.128105, for listed with performance 
and non crisis  test is 0.161354, for listed high leverage  test is 0.28284651, for 
listed high leverage and crisis test is 0.598623, for listed high leverage and non 
crisis test is 0.289721, for listed low leverage test is 0.091364, for listed low 
leverage and crisis test is 0.017158, and for listed low leverage and non crisis test 
os 0.115493. 

Based on the results of this study, the first recommendation for the firm is 
to have long term debt maturity in a situation where the country risk level is high 
during the crisis period (2009-2010). And for high profit and big size firm, it will 
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be best to take external financing or external equity. Second recommendation for 
lenders to develop loan approval concept, in order to get high revenue with low 
risk. Third recommendation for investor to invest by buying shares in company 
with high profitability and big size. In the situation where the country risk level is 
high, investor should invest on domestic firms because a high level of country risk 
will have a significant impact to multinational corporation. The last 
recommendation is for student and fellow researcher who plan to undertake 
similar research, it will be better to add dependent variables to create two stage 
least square with the same 13 test models. By using that kind of method, it is 
highly possible to produce significant effect on the test results. 
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1 GENERAL INSTRUCTIONS

1.1 Type area
The text should fit exactly into the type area of 187 

272 mm (7.36" 10.71"). For correct settings of 
margins in the Page Setup dialog box (File menu) 
see Table 1. 

1.2 Typefont, typesize and spacing
Use Times New Roman 12 point size and 13 point 
line spacing (Standard;text tag). Use roman type ex-
cept for the headings (Heading tags), parameters in 
mathematics (not for log, sin, cos, ln, max., d (in dx), 
etc), Latin names of species and genera in botany 
and zoology and the titles of journals and books 
which should all be in italics. Never use bold, except 
to denote vectors in mathematics. Never underline 
any text. Use the small font (10 points on 11 points) 
for tables (Table tags), figure captions (Figure cap-
tion tag) and the references (Reference text tag).

Never use letterspacing and never use more than 
one space after each other.

2 GETTING STARTED

2.1 Preparing the new file with the correct template
Copy the template file B2ProcA4.dot (if you print on 
A4 size paper) or B2ProcLe.dot (for Letter size pa-

per) to the template directory. This directory can be 
found by selecting the Tools menu, Options and then 
by tabbing the File Locations. When the Word pro-
gramme has been started open the File menu and 
choose New. Now select the template B2ProcA4.dot 
or B2ProcLe.dot (see above). Start by renaming the 
document by clicking Save As in the menu Files. 
Name your file as follows: First three letters of the 
file name should be the first three letters of the last 
name of the first author, the second three letters 
should be the first letter of the first three words of 
the title of the paper (e.g. this paper: balpcc.doc). 
Now you can type your paper, or copy the old ver-
sion of your paper onto this new formated file.

2.2 Copying old text onto new file
Open your old file and the new file. Switch between 
these two with the Window menu. Select all text of 
the old file (excluding title, authors, affiliations and 
abstract) and paste onto bottom of new file, after 
having deleted the word INTRODUCTION (see also 
section 2.5). Check the margin setting (Page Setup 
dialog box in File menu) and column settings (see 
Table 1 for correct settings). After this copy the texts 
which have to be placed in the frames (see sections 
2.3 and 2.4 ). In order to avoid disruption of the text 
and frames, copy these texts paragraph by paragraph 
without including the first word (which includes the 
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Table 1.  Margin settings for A4 size paper and letter size
paper.______________________________________________

Setting A4 size paper Letter size paper____________ _____________
cm inches cm inches______________________________________________

Top 1.2 0.47" 0.32      0.13"
Bottom 1.3 0.51" 0.42 0.17"
Left 1.15 0.45" 1.45 0.57"
Right 1.15 0.45" 1.45 0.57"
All other 0.0 0.0" 0.0 0.0"
Column width* 9.0 3.54" 9.0 3.54"
Column spacing* 0.7 0.28" 0.7 0.28"_____________________________________________
*  Column dialog box in Format menu.
old tag). It is best to first retype the first words man-
ually and then to paste the correct text behind. When 
the new file contains all the text, the old tags in the 
text should be replaced by the new Balkema tags 
(see section 3). Before doing this apply automatic 
formatting (AutoFormat in Format menu).

2.3 Title, author and affiliation frame

Place the cursor on the T of Title at the top of your 
newly named file and type the title of the paper in 
lower case (no caps except for proper names). The 
title should not be longer than 75 characters). Delete 
the word Title (do not delete the paragraph end). 
Place the cursor on the A of A.B.Author(s) and type 
the name of the first author (first the initials and then 
the last name). If any of the co-authors have the 
same affiliation as the first author, add his name af-
ter an & (or a comma if more names follow). Delete 
the words A.B. Author etc. and place the cursor on 
the A of Affiliation. Type the correct affiliation 
(Name of the institute, City, State/Province, Coun-
try). Now delete the word Affiliation. If there are au-
thors linked to other institutes, place the cursor at the
end of the affiliation line just typed and give a re-
turn. Now type the name(s) of the author(s) and after 
a return the affiliation. Repeat this procedure until 
all affiliations have been typed. 

All these texts fit in a frame which should not be 
changed (Width: Exactly 187 mm (7.36"); Height: 
Exactly 73 mm (2.87") from top margin; Lock an-
chor).

2.4 Abstract frame

If there are no further authors place the cursor one 
space behind the word ABSTRACT: and type your 
abstract of not more than 150 words. The top of the 
first line of the abstract will be 73 mm (2.87") from 
the top of the type area. The complete abstract will 
fall in the abstract frame, the settings of which 
should also not be changed (Width: Exactly 187 mm 
(7.36"); Height: Automatic; Vertical 73 mm (2.87") 
from margin; Lock anchor).

2.5 First line of text or heading

If your text starts with a heading, place the cursor on 
the I of INTRODUCTION and type the correct text 
for the heading. Now delete the word INTRODUC-
TION and start with the text after a return. This text 
should have the tag First paragraph.

If your text starts without a heading you should 
place the cursor on the I of INTRODUCTION, 
change the tag to First paragraph and type your text 
after deleting the word INTRODUCTION.

3 LAYOUT OF TEXT

3.1 Text and indenting
Text is set in two columns of 9 cm (3.54") width 
each with 7 mm (0.28") spacing between the col-
umns. All text should be typed in Times New Ro-
man, 12 pt on 13 pt line spacing except for the paper 
title (18 pt on 20 pt), author(s) (14 pt on 16 pt), and
the small text in tables, captions and references (10 
pt on 11 pt). All line spacing is exact. Never add any 
space between lines or paragraphs. When a column 
has blank lines at the bottom of the page, add space 
above and below headings (see opposite column).

First lines of paragraphs are indented 5 mm (0.2") 
except for paragraphs after a heading or a blank line 
(First paragraph tag).

3.2 Headings
Type primary headings in capital letters roman 
(Heading 1 tag) and secondary and tertiary  headings 
in lower case italics (Headings 2 and 3 tags). Head-
ings are set flush against the left margin. The tag 
will give two blank lines (26 pt) above and one (13 
pt) beneath the primary headings, 1½ blank lines (20 
pt) above and a ½ blank line (6 pt) beneath the sec-
ondary headings and one blank line (13 pt) above the 
tertiary headings. Headings are not indented and nei-
ther are the first lines of text following the heading 
indented. If a primary heading is directly followed 
by a secondary heading, only a ½ blank line should 
be set between the two headings. In the Word pro-
gramme this has to be done manually as follows: 
Place the cursor on the primary heading, select Para-
graph in the Format menu, and change the setting for 
spacing after, from 13 pt to 0 pt. In the same way the 
setting in the secondary heading for spacing before 
should be changed from 20 pt to 7 pt.

3.3 Listing and numbering
When listing facts use either the style tag List signs 
or the style tag List numbers.



3.4 Equations
Use the equation editor of the selected word pro-
cessing programme. Equations are not indented 
(Formula tag). Number equations consecutively and 
place the number with the tab key at the end of the 
line, between parantheses. Refer to equations by 
these numbers. See for example Equation 1 below:

From the above we note that sin = (x + y)z or:

K
R

c
kt

a
1

2 4

1tan
(1)

where ca = interface adhesion; = friction angle at 
interface; and k1 = shear stiffness number.

For simple equations in the text always use super-
script and subscript (select Font in the Format
menu). Do not use the equation editor between text 
on same line.

The inline equations (equations within a sen-
tence) in the text will automatically be converted to 
the AMS notation standard.

3.5 Tables
Locate tables close to the first reference to them in 
the text and number them consecutively. Avoid ab-
breviations in column headings. Indicate units in the 
line immediately below the heading. Explanations 
should be given at the foot of the table, not within 
the table itself. Use only horizontal rules: One above 
and one below the column headings and one at the 
foot of the table (Table rule tag: Use the Shift-minus 
key to actually type the rule exactly where you want 
it). For simple tables use the tab key and not the ta-
ble option. Type all text in tables in small type: 10 
on 11 points (Table text tag). Align all headings to 
the left of their column and start these headings with 
an initial capital. Type the caption above the table to 
the same width as the table (Table caption tag). See 
for example Table 1.

3.6 Figure captions
Always use the Figure caption style tag (10 points 
size on 11 points line space). Place the caption un-
derneath the figure (see Section 5). Type as follows: 
‘Figure 1. Caption.’ Leave about two lines of space 
between the figure caption and the text of the paper.

3.7 References
In the text, place the authors’ last names (without in-
itials) and the date of publication in parentheses (see 
examples in Section 5). At the end of the paper, list 
all references in alphabetical order underneath the 
heading REFERENCES (Reference heading   tag). 
The references should be typed in small text (10 pt 
on 11 pt) and second and further lines should be in-

dented 5.0 mm (0.2") (Reference text tag). If several 
works by the same author are cited, entries should be 
chronological:
Larch, A.A. 1996a. Development ...
Larch, A.A. 1996b. Facilities ...
Larch, A.A. 1997. Computer ...
Larch, A.A. & Jensen, M.C. 1996. Effects of ...
Larch, A.A. & Smith, B.P. 1993. Alpine ...

3.7.1 Typography for references 
Last name, First name or Initials (ed.) year. Book title. City: 

Publisher.
Last name, First name or Initials year. Title of article. Title of 

Journal (series number if necessary) volume number (issue 
number if necessary): page numbers.

3.7.2 Examples
Grove, A.T. 1980. Geomorphic evolution of the Sahara and the 

Nile. In M.A.J. Williams & H. Faure (eds), The Sahara and 
the Nile: 21-35. Rotterdam: Balkema.

Jappelli, R. & Marconi, N. 1997. Recommendations and preju-
dices in the realm of foundation engineering in Italy: A his-
torical review. In Carlo Viggiani (ed.), Geotechnical engi-
neering for the preservation of monuments and historical 
sites; Proc. intern. symp., Napoli, 3-4 October 1996. Rot-
terdam: Balkema.

Johnson, H.L. 1965. Artistic development in autistic children. 
Child Development 65(1): 13-16.

Polhill, R.M. 1982. Crotalaria in Africa and Madagascar. Rot-
terdam: Balkema.

3.8 Notes
These should be avoided. Insert the information in 
the text. In tables the following reference marks 
should be used: *, **, etc. and the actual footnotes  
set directly underneath the table.

3.9 Conclusions
Conclusions should state concisely the most im-
portant propositions of the paper as well as the au-
thor’s views of the practical implications of the re-
sults.

4 PHOTOGRAPHS AND FIGURES

Number figures consecutively in the order in which 
reference is made to them in the text, making no dis-
tinction between diagrams and photographs. Figures 
should fit within the column width of 90 mm (3.54") 
or within the type area width of 187 mm (7.36").
Figures, photographs, etc. can be in black/white or 
full color, but will be produced in the book in 
black/white only. Paste copies of the same size onto 
the typescript where you want them to appear in the 
text. Do not place them sideways on a page; howev-
er if this cannot be avoided, no other text (except the 
figure caption) should appear on that page. Figures, 
etc. should not be centered, but placed against the 



left margin. Leave about two lines of space between 
the actual text and figure (including caption). Nev-
er place any text next to a figure. Leave this space 
blank. The most convenient place for placing figures 
is at the top or bottom of the page. Avoid placing 
text between figures as readers might not notice the 
text. Keep in mind that everything will be reduced to 
75%. Therefore, 9 point should be the minimum size 
of the lettering. Lines should preferably be 0.2 mm 
(0.1") thick. Keep figures as simple as possible. 
Avoid excessive notes and designations.

Figure 1. Caption of a typical figure. Photographs will be 
scanned by the printer. Always supply original photographs.

Photographs should be with good contrast and on 
glossy paper. Photographic reproductions cut from 
books or journals, photocopies of photographs and 
screened photographs are unacceptable. The pro-
ceedings will be printed in black only. For this rea-
son avoid the use of colour in figures and photo-
graphs. Colour is also nearly always unnecessary for 
scientific work.

5 PREFERENCES, SYMBOLS AND UNITS

Consistency of style is very important. Note the 
spacing, punctuation and caps in all the examples 
below.

References in the text: Figure 1, Figures 2-4, 6, 
8a, b (not abbreviated)
References between parentheses: (Fig. 1), (Figs 
2-4, 6, 8a, b) (abbreviated)
USA / UK / Netherlands / the Netherlands instead 
of U.S.A. / U.K. / The Netherlands
Author & Author (1989) instead of Author and 
Author (1989)
(Author 1989a, b, Author & Author 1987) instead
of (Author, 1989a,b; Author and Author, 1987)
(Author et al. 1989) instead of (Author, Author & 
Author 1989)

Use the following style: (Author, in press); (Au-
thor, in prep.); (Author, unpubl.); (Author, pers. 
comm.)

Always use the official SI notations:
kg / m / kJ / mm instead of kg. (Kg) / m. / kJ. 
(KJ) / mm.; 
20°16 32 SW instead of 20° 16 32 SW
0.50 instead of 0,50 (used in French text); 9000 
instead of 9,000 but if more than 10,000: 10,000 
instead of 10000
14C instead of C14 / C-14 and BP / BC / AD in-
stead of B.P. / B.C. / A.D.
× 20 instead of 20 / X20 / x 20; 4 + 5 > 7 in-
stead of 4+5>7 but –8 / +8 instead of – 8 / + 8
e.g. / i.e. instead of e.g., / i.e.,

6 SUBMISSION OF MATERIAL TO THE 
EDITOR

The camera-ready copy of the complete paper print-
ed on a high resolution printer on one side of the pa-
per as well as two copies of the paper should be sent 
to the editor after receiving the final acceptance no-
tice. The paper should be sent together with the 
signed Copyright form. Include the original photo-
graphs. Check whether the paper looks the same as 
this sample: Title at top of first page in 18 points, 
authors in 14 points and all other text in 12 points on 
13 points line space, except for the small text (10 
point on 11 point line space) used in tables, captions 
and references. Also check if the type width is 187 
mm (7.36"), the column width 90 mm (3.54"), the 
page length is 272 mm (10.71") and that the space 
above the Abstact is exactly as in the sample. Write 
your name and the shortened title of the paper in 
pencil in the bottom margin of each page and num-
ber the pages correctly.

7 DEADLINE

The above material should be with the editor before 
the deadline for submission. Any material received 
too late will not be published. Send the material by 
airmail or by courier well packed and in time. Be 
sure that all pages are included in the parcel.


